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Projection neurons from medial entorhinal cortex
to basolateral amygdala are critical
for the retrieval of morphine withdrawal memory

Yali Fu,1 Zixuan Cao,1 Ting Ye,1 Hao Yang,1 Chenshan Chu,1 Chao Lei,1 Yaxian Wen,1 Zhangyin Cai,1 Yu Yuan,1

Xinli Guo,1 Li Yang,1 Huan Sheng,1 Dongyang Cui,1 Da Shao,1 Ming Chen,1,* Bin Lai,1,* and Ping Zheng1,2,3,*
SUMMARY

The medial entorhinal cortex (MEC) is crucial for contextual memory, yet its role in context-induced
retrieval of morphine withdrawal memory remains unclear. This study investigated the role of the MEC
and its projection neurons from MEC layer 5 to the basolateral amygdala (BLA) (MEC�BLA neurons) in
context-induced retrieval of morphine withdrawal memory. Results show that context activates the
MEC in morphine withdrawal mice, and the inactivation of the MEC inhibits context-induced retrieval
of morphinewithdrawal memory. At neural circuits, context activatesMEC�BLA neurons in morphinewith-
drawal mice, and the inactivation of MEC�BLA neurons inhibits context-induced retrieval of morphine
withdrawal memory. But MEC�BLA neurons are not activated by conditioning of context and morphine
withdrawal, and the inhibition of MEC�BLA neurons do not influence the coupling of context and
morphine withdrawal memory. These results suggest that MEC�BLA neurons are critical for the retrieval,
but not for the formation, of morphine withdrawal memory.

INTRODUCTION

The medial entorhinal cortex (MEC) plays an important role in physiological processes underlying spatial navigation and related memory.1,2

The function of the MEC is closely related to the specialized representation of contextual information.3 Many MEC cells show strong context

sensitivity.4 In addition, it has been reported that the MEC is involved in context-induced fear memory retrieval.5,6 However, it remains un-

known whether the MEC also mediates context-induced retrieval of morphine withdrawal memory.

The MEC has direct projection to the dorsal hippocampus (dHIP).7 Optogenetic experiments have identified grid cells as the most abun-

dant MEC cell type projecting to the dHIP.7 Further studies demonstrated that the MEC grid cell network integrated information on location,

direction, distance, and speed, which in turn directly influenced hippocampal responses to spatial stimuli and could be integrated into new

memories in the dHIP.8–12 However, the optogenetic inhibition of MEC-dHIP at 30 min before retrieval test did not affect freezing during

retrieval test.13 These studies indicate that projection neurons from theMEC to the dHIP (MEC-dHIP) may bemainly related to its role in spatial

navigation and spatial memory,14 rather than context-induced retrieval of fear memory.

The MEC also has direct projection to the basolateral amygdala (BLA).15 The BLA is an important brain structure that mediates context-

induced retrieval of morphine withdrawal memory. Re-exposure to conditioned context by morphine withdrawal rats could activate BLA neu-

rons.5,6 Lesion in the BLA attenuated conditioned context-induced food aversion in morphine withdrawal rats.16 Studies from our lab showed

that conditioned context activated BLA projection neurons to the PrL, and in vivo chemogenetic inhibition of these projection neurons could

significantly inhibit context-induced retrieval of morphine withdrawal memory.17 However, whether projection neurons from the layer 5 neu-

rons of the MEC to the BLA (MEC�BLA) mediates context-induced retrieval of morphine withdrawal memory remains unknown.

We propose a hypothesis that the MEC mediates context-induced retrieval of morphine withdrawal memory, and among different pro-

jection neurons of the MEC, MEC�BLA are the ones that mediate context-induced retrieval of morphine withdrawal memory. To test this hy-

pothesis, firstly, we studied the role of the MEC in the context-induced retrieval of morphine withdrawal memory by examining c-Fos expres-

sion using immunofluorescence staining method after context exposure and the influence of the inactivation of the MEC using the GABAA

receptor agonist muscimol on context-induced retrieval of morphinewithdrawalmemory. Second, we studied the role ofMEC�BLA neurons in

the context-induced retrieval of morphine withdrawal memory by FluoroGold (FG) retrograde tracing and chemogenetic method. Lastly, we

studied how MEC�BLA neurons participated in the context-induced retrieval of morphine withdrawal memory using multiple approaches.
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Figure 1. The role of the MEC in the retrieval of morphine withdrawal memory

(A) Behavioral schedule and groups of the mice.

(B) The average CPA scores in Saline + Saline group (n = 6), Morphine + Saline group (n = 7), Saline + Naloxone group (n = 8), and Morphine + Naloxone group

(n= 10). Two-way repeatedmeasures (RM) ANOVA, drug factor, F (3, 27) = 16.30, p< 0.0001; test factor, F (1, 27) = 34.21, p< 0.0001; drug3 test interaction, F (3, 27) =

17.88, p < 0.0001. ****p < 0.0001 versus pre-test.

(C) The c-Fos labeling neurons and DAPI labeling neurons in the MEC in four groups. Scale bar: 100 mm. Magnified images showed the boxed areas. Scale bar:

20 mm.

(D) The average c-Fos labeling neurons in theMEC in four groups. (n= 5mice in Saline+Saline group,Morphine+Saline group, and Saline+Naloxone group; n= 8

mice in Morphine+Naloxone group). Two-way ANOVA, conditioning treatment factor, F (1, 19) = 8.034, p = 0.011; withdrawal treatment factor, F (1, 19) = 2.592,

p = 0.124; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 11.856, p = 0.003. ###p < 0.001 versus Saline + Saline group, Morphine +

Saline group, and Saline + Naloxone group by Bonferroni’s post hoc test.

(E) Behavioral schedule and groups of the mice.

(F) The anatomical location of muscimol injection site in the MEC. Scale bar: 500 mm.

(G) The average CPA scores in Saline group (n = 6) andMuscimol group (n = 7). Two-way RM ANOVA, drug factor, F (1, 11) = 31.14, p = 0.0002; test factor, F (1, 11) =

49.78, p < 0.0001; drug 3 test interaction, F (1, 11) = 28.34, p = 0.0002. ***p < 0.001 versus pre-test, ####p < 0.0001 versus post-test of Saline group. Data are

represented as mean G SEM.
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RESULTS

MEC participates in context-induced retrieval of morphine withdrawal memory

To study the role of theMEC in context-induced retrieval of morphinewithdrawal memory, firstly, we examined the influence of context on the

expression of c-Fos, a marker of neural activation,18 in the MEC. Mice were randomly divided into four groups: the Saline + Saline group, in

which the saline-treated mice received saline injection during the conditioning sessions; the Morphine + Saline group, in which the chronic

morphine-treated mice received saline injection during the conditioning sessions; the Saline + Naloxone group, in which the saline-treated

mice received naloxone injection during the conditioning sessions; the Morphine + Naloxone group, in which the chronic morphine-treated

mice received naloxone injection during the conditioning sessions. The mice in each group were subjected to the behavioral training as illus-

trated in Figure 1A. The results showed that themice inMorphine +Naloxone group exhibited a strong aversion to themorphine withdrawal-

paired compartment and spent less time in it during the post-test than that during the pre-test, whereasmice in other groups did not exhibit a

significant aversion to either compartment (two-way repeated measures [RM] ANOVA, drug factor, F (3, 27) = 16.30, p < 0.0001; test factor,

F (1, 27) = 34.21, p < 0.0001; drug 3 test interaction, F (3, 27) = 17.88, p < 0.0001. Bonferroni’s multiple comparisons: there were no significant

differences between groups in the pre-test: p > 0.9999; the post-test of Morphine + Naloxone group vs. Saline + Saline group, Morphine +

Saline group, or Saline + Naloxone group: p < 0.0001; Table S1A and Figure 1B). After the behavioral assay, mice were sacrificed at 90 min

after the post-test, and the effect of conditioned context on the expression of c-Fos in theMEC in different groups was examined (Figure 1C).

We could see that the average c-Fos labeling neurons/mm2 in theMEC inMorphine +Naloxone group (269.9G 25.64/mm2) was significantly

higher than that in Saline + Saline group (170.5G 16.19/mm2), Morphine + Saline group (156.9G 17.03/mm2), and Saline + Naloxone group

(129.5 G 15.13/mm2) (two-way ANOVA, conditioning treatment [saline/morphine] factor, F (1, 19) = 8.034, p = 0.011; withdrawal treatment

[saline/naloxone] factor, F (1, 19) = 2.592, p = 0.124; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 11.856, p = 0.003;

Figure 1D). This result suggests that context can activate the MEC during context-induced retrieval of morphine withdrawal memory.

To further study the role of the MEC in context-induced retrieval of morphine withdrawal memory, we examined the influence of the inac-

tivation of the MEC, using the GABAA receptor agonist muscimol, on context-induced retrieval of morphine withdrawal memory. One week

after recovery of the cannula embedment surgery (Figure S1A), mice were randomly divided into two groups: one was Saline group, in which

the mice received intra-MEC injection of saline at 30 min before the post-test; another one was Muscimol group, in which the mice received

intra-MEC injection ofmuscimol at 30min before the post-test to inactivate theMECneurons during the post-test (Figure 1E). Figures S1B and

S1C showed the anatomical locations of injection site in each group. The result in Figure 1G showed that context induced a strong aversion to

morphinewithdrawal-paired compartment in themice of Saline group, but it did not induce a significant aversion to themorphinewithdrawal-

paired compartment in the mice of Muscimol group (two-way RM ANOVA, drug factor, F (1, 11) = 31.14, p = 0.0002; test factor, F (1, 11) = 49.78,

p < 0.0001; drug 3 test interaction, F (1, 11) = 28.34, p = 0.0002. Bonferroni’s multiple comparisons: there were no significant differences be-

tween groups in the pre-test: p = 0.9910; the post-test of Muscimol group vs. Saline group: p < 0.0001; Figure 1G). This result suggests that

context-induced activation of the MEC plays an important role in context-induced retrieval of morphine withdrawal memory.
MEC�BLA neurons participate in context-induced retrieval of morphine withdrawal memory

To studywhetherMEC�BLA neuronsmediate context-induced retrieval of morphinewithdrawal memory, firstly, we examinedwhether context

could activate MEC�BLA neurons using c-Fos as a marker of neural activation. Retrograde tracer FG was bilaterally injected into the BLA to

retrograde labelMEC�BLA neurons. After recovery from the surgery of FG injection,micewere randomly divided into four groups as described

earlier and were subjected to the behavioral training as illustrated in Figure 2A. Figure 2B showed the anatomical location of FG injection site

in the BLA and the FG-labeled neurons in theMEC. Figure S2A showed the diagram of FG injection in the BLA. Figure S2B showed the spread

of FG in each group. The results showed that the mice in Morphine + Naloxone group exhibited a strong aversion to the morphine

withdrawal-paired compartment and spent less time in it during the post-test than that during the pre-test, whereas mice in other

groups did not exhibit a significant aversion to either compartment (two-way RM ANOVA, drug factor, F (3, 31) = 15.31, p < 0.0001; test factor,
iScience 27, 110239, July 19, 2024 3
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Figure 2. The influence of context on the MEC�BLA during the context-induced retrieval of morphine withdrawal memory

(A) Behavioral schedule and groups of the mice.

(B) Left: the diagram of FG injection into the BLA. Scale bar: 100 mm.Magnified images showed the boxed areas. Scale bar: 20 mm. Right: the FG labeling neurons

in the MEC. Scale bar: 500 mm.

(C) The average CPA scores in Saline + Saline group (n = 8), Morphine + Saline group (n = 8), Saline + Naloxone group (n = 9), and Morphine + Naloxone group

(n = 10). Two-way RM ANOVA, drug factor, F (3, 31) = 15.31, p < 0.0001; test factor, F (1, 31) = 21.04, p < 0.0001; drug3 test interaction, F (3, 31) = 16.62, p < 0.0001.

****p < 0.0001 versus pre-test.

(D) The c-Fos labeling neurons, FG labeling neurons, and c-Fos and FG co-labeling neurons in the MEC in four groups. Scale bar: 100 mm. Magnified images

showed the boxed areas. Scale bar: 20 mm.

(E) The average percentage of the c-Fos and FG co-labeling neurons relative to the FG labeling neurons in the MEC in four groups (n = 7 mice in Saline+Saline

group and Saline+Naloxone group; n = 6 mice in Morphine+Saline group and Morphine+Naloxone group). Two-way ANOVA, conditioning treatment factor,

F (1, 22) = 7.415, p = 0.012; withdrawal treatment factor, F (1, 22) = 9.143, p = 0.006; conditioning treatment x withdrawal treatment interaction, F (1, 22) = 25.611,

p < 0.0001. ####p < 0.0001 versus Saline + Saline group, Morphine + Saline group, and Saline + Naloxone group by Bonferroni’s post hoc test.

(F) The density of FG labeling neurons in theMEC in four groups. Two-way ANOVA, conditioning treatment factor, F (1, 22) = 0.703, p= 0.411; withdrawal treatment

factor, F (1, 22) = 0.106, p = 0.748; conditioning treatment x withdrawal treatment interaction, F (1, 22) = 3.898, p = 0.061. Data are represented as mean G SEM.

ll
OPEN ACCESS

iScience
Article
F (1, 31) = 21.04, p < 0.0001; drug 3 test interaction, F (3, 31) = 16.62, p < 0.0001. Bonferroni’s multiple comparisons: there were no significant

differences between groups in the pre-test: p > 0.05 [Table S1B]; the post-test of Morphine + Naloxone group vs. Saline + Saline group,

Morphine + Saline group, or Saline + Naloxone group: p < 0.0001; Table S1B and Figure 2C). After the behavioral assay, mice were sacrificed

at 90 min after the post-test, and the effect of context on the expression of c-Fos in MEC�BLA neurons in different groups was examined (Fig-

ure 2D). We could see that the average percentage of the c-Fos and FG colabeling neurons relative to FG-labeling neurons in the MEC in

Morphine + Naloxone group (20.55G 1.08%) was significantly higher than that in Saline + Saline group (14.26G 1.12%), Morphine + Saline

group (11.7 G 1.38%), and Saline + Naloxone group (12.03 G 0.78%) (two-way ANOVA, conditioning treatment factor, F (1, 22) = 7.415,

p = 0.012; withdrawal treatment factor, F (1, 22) = 9.143, p = 0.006; conditioning treatment x withdrawal treatment interaction, F (1, 22) =

25.611, p < 0.0001; Figure 2E). This result suggests that context can activate MEC�BLA neurons during context-induced retrieval of morphine

withdrawal memory.

Next, we examined the influence of the inhibition of MEC�BLA neurons, using chemogenetic method, on the context-induced retrieval of

morphine withdrawal memory. Firstly, the inhibition efficiency of DIO-hM4D(Gi) was examined by detecting the expression of c-Fos in

MEC�BLA during retrieval of morphine withdrawal memory. AAV-DIO-hM4D(Gi)-EGFP was bilaterally injected into the MEC, and rAAV-

CRE was bilaterally injected into the BLA of the mice. Four weeks after recovery of the surgery, the mice were randomly divided into two

groups: one was Saline group, in which the mice received intraperitoneal injection of saline at 45 min before the post-test; another one

was CNO group, in which the mice received intraperitoneal injection of CNO at 45 min before the post-test to inhibit the activity of

MEC�BLA neurons during the post-test (Figure S3A). The result in Figure S3C showed that context induced a strong aversion to morphine

withdrawal-paired compartment in Saline group but did not in the CNO group (two-way RM ANOVA, CNO factor, F (1, 10) = 15.10,

p = 0.003; test factor, F (1, 10) = 47.29, p < 0.0001; drug3 test interaction, F (1, 10) = 23.56, p = 0.0007. Bonferroni’s multiple comparisons: there

were no significant differences between groups in the pre-test: p > 0.9999; the post-test of CNO group vs. Saline group: p < 0.0001; Fig-

ure S3C). Then the mice were sacrificed at 90 min after the post-test, and the expression of c-Fos in the MEC�BLA neurons in different groups

was examined (Figure S3D). We could see that the average percentage of the c-Fos and hM4D(Gi)-EGFP colabeling neurons relative to

hM4D(Gi)-EGFP labeling neurons in the MEC in CNO group (10.52 G 0.64%) was significantly lower than that in Saline group (18.15 G

0.56%) (Student’s t test, t5 = 8.58, p = 0.0004; Figure S3E). This result shows that DIO-hM4D(Gi) can inhibit the expression of c-Fos in

MEC�BLA neurons during retrieval of morphine withdrawal memory, suggesting that this approach can effectively inhibit the activity of

MEC�BLA neurons. On this basis, we examined the influence of the inhibition of MEC�BLA neurons, using chemogenetic method, on

context-induced retrieval of morphine withdrawal memory. AAV-DIO-hM4D(Gi)-EGFP or AAV-DIO-EGFP was bilaterally injected into the

MEC, and rAAV-CRE-mCherry was bilaterally injected into the BLA of the mice. Four weeks after recovery of the surgery, mice with the injec-

tion of AAV-DIO-hM4D(Gi)-EGFPwere randomly divided into two groups: one was hM4D(Gi) + Saline group, in which themice received intra-

peritoneal injection of saline at 45 min before the post-test; another one was hM4D(Gi) + clozapine-n-oxide (CNO) group, in which the mice

received intraperitoneal injection of CNO at 45 min before the post-test to inhibit the activity of MEC�BLA neurons during the post-test. The

mice with the injection of AAV-DIO-EGFP were set as the empty vector control group (EGFP + CNO group), in which the mice received intra-

peritoneal injection of CNOat 45min before the post-test to exclude the effect of CNOon theCPA (Figure 3A). Figures 3B and 3C showed the

mCherry-labeled neurons in the BLA and the EGPF-labeled neurons in theMEC. Figure S4A showed the diagram of virus injection in theMEC

and the BLA. Figures S4B and S4C showed the injection sites for data analysis in the MEC and the BLA. The result in Figure 3D showed that

context induced a strong aversion to morphine withdrawal-paired compartment in hM4D(Gi) + Saline group and EGFP + CNOgroup but did

not in the hM4D(Gi) + CNOgroup (two-way RMANOVA, drug factor, F (1, 21) = 147.2, p< 0.0001; test factor, F (1, 21) = 14.68, p= 0.0001; drug3

test interaction, F (2, 21) = 17.99, p < 0.0001. Bonferroni’s multiple comparisons: there were no significant differences between groups in the

pre-test: p > 0.05; the post-test of hM4D(Gi) + CNO group vs. hM4D(Gi) + Saline group or EGFP + CNO group: p < 0.0001; Table S1C and

Figure 3D). This result suggests that context-induced activation of MEC�BLA neurons plays an important role in context-induced retrieval of

morphine withdrawal memory.

To eliminate that the aversive response to the compartment was due to a physiological effect induced by the activation of MEC�BLA neu-

rons, we examined whether the artificial activation of MEC�BLA neurons, using chemogenetic method, could induce an aversive response to
iScience 27, 110239, July 19, 2024 5



Figure 3. The influence of chemogenetic manipulation of MEC�BLA on the context-induced retrieval of morphine withdrawal memory and the aversive

response to compartment in normal mice

(A) Behavioral schedule and groups of the mice.

(B) The expression of CRE-mCherry (red) in the BLA. Scale bar: 100 mm. Magnified images showed the boxed areas. Scale bar: 20 mm.

(C) The expression of hM4D(Gi)-EGFP (green) in the MEC. Scale bar: 100 mm.
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Figure 3. Continued

(D) The average CPA scores in hM4D(Gi) + Saline group (n = 10), hM4D(Gi) + CNO group (n = 7), and EGFP + CNO group (n = 7). Two-way RM ANOVA, drug

factor, F (1, 21) = 147.2, p < 0.0001; test factor, F (1, 21) = 14.68, p = 0.0001; drug 3 test interaction, F (2, 21) = 17.99, p < 0.0001. ****p < 0.0001 versus pre-test,
####p < 0.0001 versus post-test of hM4D(Gi) + Saline group or EGFP + CNO group.

(E) Behavioral schedule and groups of the mice.

(F) The expression of CRE-mCherry (red) in the BLA. Scale bar: 100 mm. Magnified images showed the boxed areas. Scale bar: 20 mm.

(G) The expression of hM3D(Gq)-EGFP (green) in the MEC. Scale bar: 100 mm.

(H) The average CPA scores in hM3D(Gq) + Saline group (n = 9), hM3D(Gq) + CNO group (n = 11), and EGFP + CNO group (n = 6). Two-way RM ANOVA, CNO

factor, F (2, 23) = 0.8100, p = 0.4571; test factor, F (1, 23) = 1.374, p = 0.2531; CNO3 test interaction, F (2, 23) = 0.4375, p = 0.6509. Data are represented as meanG

SEM.
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compartment in normal mice. AAV-DIO-hM3D(Gq)-EGFP or AAV-DIO-EGFP was bilaterally injected into the MEC, and rAAV-CRE-mCherry

was bilaterally injected into the BLA of the mice. Four weeks after recovery of the surgery, mice with the injection of AAV-DIO-hM3D(Gq)-

EGFP were randomly divided into two groups: one was hM3D(Gq) + Saline group, in which the mice received intraperitoneal injection of sa-

line at 45 min before being confined in either compartment; another one was hM3D(Gq) + CNO group, in which the mice received intraper-

itoneal injection of CNO at 45 min before being confined in the CNO-paired compartment to activate MEC�BLA neurons. The mice with the

injection of AAV-DIO-EGFP were set as the empty vector control group (EGFP + CNO group), in which the mice received intraperitoneal in-

jection of CNOat 45min before being confined in the CNO-paired compartment to exclude the effect of CNOon the CPA. Figure 3E showed

a schematic of the experimental design for CPA anddrug application. Figures 3F and 3G showedmCherry-labeled neurons in the BLA and the

EGFP-labeled neurons in the MEC. Figure S5A showed the diagram of virus injection in the MEC and the BLA. Figures S5B and S5C showed

the injection sites for data analysis in the MEC and the BLA. The result in Figure 3H showed that as the mice in hM3D(Gq) + Saline group and

EGFP + CNO group, the mice in the hM3D(Gq) + CNO group also did not show an aversive response to the CNO-paired compartment (two-

way RMANOVA, CNO factor, F (2, 23) = 0.8100, p = 0.4571; test factor, F (1, 23) = 1.374, p = 0.2531; CNO3 test interaction, F (2, 23) = 0.4375, p =

0.6509. Bonferroni’s multiple comparisons: there were no significant differences between groups in the pre-test: p > 0.05 (Table S1D); the

post-test of hM3D(Gq) + CNO group vs. hM3D(Gq) + Saline group or EGFP + CNO group: p > 0.9999; Figure 3H). This result suggests

that the activation of MEC�BLA neurons does not induce an aversive response to the compartment in normal mice.
MEC�BLA neurons play an important role in context-induced reactivation of morphine withdrawal memory engram cells of

the BLA

To study how MEC�BLA neurons mediate context-induced retrieval of morphine withdrawal memory, we examined the influence of the in-

hibition of MEC�BLA neurons, using chemogenetic method, on context-induced reactivation of morphine withdrawal memory engram cells

of the BLA. Firstly, we examined whether there were morphine withdrawal memory engram cells in the BLA using a virus-mediated strategy.

AAV-c-Fos-tetracycline-controlled transactivator (tTA) and AAV-TRE3g-H2B-EGFP were bilaterally injected into the BLA of the mice. Four

weeks after surgery, mice were randomly divided into four groups as described earlier and were subjected to the behavioral training as illus-

trated in Figure 4A to examine whether conditioning of context and morphine withdrawal could activate neurons in the BLA. Figure 4B

showed the diagram of virus injection in the BLA. Figure S6 showed the injection sites for data analysis in the BLA. The cells activated during

the above conditioning in the absence of doxycycline (DOX) were taggedbyH2B-EGFP for next examiningwhether context-induced retrieval

of morphine withdrawal memory could reactivate these neurons, which was an important requirement for memory engram cells.19 The result

showed that during conditioning of context and morphine withdrawal, the average H2B-EGFP labeling neurons/mm2 in the BLA in

Morphine + Naloxone group (712.3 G 23.44/mm2) was significantly higher than that in Saline + Saline group (239.4 G 32.65/mm2),

Morphine + Saline group (414.7G 56.74/mm2), and Saline +Naloxone group (266.6G 50.11/mm2) (two-way ANOVA, conditioning treatment

factor, F (1, 19) = 53.614, p < 0.0001; withdrawal treatment factor, F (1, 19) = 14.659, p = 0.0011; conditioning treatment x withdrawal treatment

interaction, F (1, 19) = 10.171, p = 0.0048; Figure 4E). This result indicated that BLA neurons were activated during conditioning of context and

morphine withdrawal. Then, we examined whether context-induced retrieval of morphine withdrawal memory still activated these neurons

tagged by H2B-EGFP. The behavioral results showed that the mice in Morphine + Naloxone group exhibited a strong aversion to the

morphine withdrawal-paired compartment and spent less time in it during the post-test than that during the pre-test, whereas mice in other

groups did not exhibit a significant aversion to either compartment (two-way RM ANOVA, drug factor, F (3, 21) = 37.46, p < 0.0001; test factor,

F (1, 21) = 27.96, p < 0.0001; drug 3 test interaction, F (3, 21) = 16.42, p < 0.0001. Bonferroni’s multiple comparisons: there were no significant

differences between groups in the pre-test: p > 0.05; the post-test of Morphine + Naloxone group vs. Saline + Saline group, Morphine +

Saline group, or Saline + Naloxone group: p < 0.0001; Table S1E and Figure 4C). After the behavioral testing for the retrieval of morphine

withdrawal memory, mice were sacrificed at 90 min after the post-test, and the expression of c-Fos in the BLA and the colabeling of H2B-

EGFP and c-Fos in these neurons tagged by H2B-EGFP was examined (Figure 4D). The result showed that during context-induced retrieval

of morphine withdrawal memory, the average c-Fos labeling neurons/mm2 in the BLA in Morphine + Naloxone group (310.4G 38.28/mm2)

was significantly higher than that in Saline + Saline group (112.8 G 12.17/mm2), Morphine + Saline group (110.4 G 14.7/mm2), and Saline +

Naloxone group (171.4G 27.03/mm2) (two-way ANOVA, conditioning treatment factor, F (1, 19) = 7.285, p = 0.014; withdrawal treatment fac-

tor, F (1, 19) = 26.11, p< 0.0001; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 7.813, p= 0.012; Figure 4F). This indicates

that BLA neurons were activated during the context-induced retrieval of morphinewithdrawal memory. Moreover, the average number of the

H2B-EGFP and c-Fos colabeling neurons/mm2 in the BLA in Morphine + Naloxone group (47.7 G 7.055/mm2) was significantly higher than
iScience 27, 110239, July 19, 2024 7
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Figure 4. The role of BLA neurons in the conditioning of context and morphine withdrawal and the context-induced retrieval of morphine withdrawal

memory

(A) Behavioral schedule and groups of the mice.

(B) The diagram of virus injection into the BLA.

(C) The average CPA scores in Saline + Saline group (n = 7), Morphine + Saline group (n = 6), Saline + Naloxone group (n = 6), and Morphine + Naloxone group

(n = 6). Two-way RM ANOVA, drug factor, F (3, 21) = 37.46, p < 0.0001; test factor, F (1, 21) = 27.96, p < 0.0001; drug 3 test interaction, F (3, 21) = 16.42, p < 0.0001.

****p < 0.0001 versus pre-test.

(D) The H2B-EGFP labeling neurons, c-Fos labeling neurons, H2B-EGFP and c-Fos co-labeling neurons in the BLA in four groups. Scale bar: 100 mm. Magnified

images showed the boxed areas. Scale bar: 20 mm.

(E) The average H2B-EGFP labeling neurons in the BLA in four groups. (n = 6 mice in Saline + Saline group, Morphine + Saline group, and Morphine + Naloxone

group; n= 5mice in Saline +Naloxone group). Two-way ANOVA, conditioning treatment factor, F (1, 19) = 53.614, p< 0.0001; withdrawal treatment factor, F (1, 19) =

14.659, p = 0.0011; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 10.171, p = 0.0048. ####p < 0.0001 versus Saline + Saline group,

Morphine + Saline group, and Saline + Naloxone group by Bonferroni’s post hoc test.

(F) The average c-Fos labeling neurons in the BLA in four groups (n= 6mice in Saline + Saline group, Morphine + Saline group, andMorphine +Naloxone group;

n = 5 mice in Saline + Naloxone group). Two-way ANOVA, conditioning treatment factor, F (1, 19) = 7.285, p = 0.014; withdrawal treatment factor, F (1, 19) = 26.11,

p < 0.0001; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 7.813, p = 0.012. ####p < 0.0001 versus Saline + Saline group, Morphine + Saline

group, and Saline + Naloxone group by Bonferroni’s post hoc test.

(G) The average number of the H2B-EGFP and c-Fos co-labeling neurons in the BLA in four groups. (n= 6mice in Saline + Saline group, Morphine + Saline group,

andMorphine +Naloxone group; n= 5mice in Saline +Naloxone group). Two-way ANOVA, conditioning treatment factor, F (1, 19) = 32.94, p< 0.0001; withdrawal

treatment factor, F (1, 19) = 24.61, p < 0.0001; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 27.11, p < 0.0001. ####p < 0.0001 versus Saline +

Saline group, Morphine + Saline group, and Saline + Naloxone group by Bonferroni’s post hoc test.

(H) The average percentage of H2B-EGFP and c-Fos co-labeling neurons relative to the H2B-EGFP labeling neurons in the BLA in four groups. (n = 6 mice in

Saline + Saline group, Morphine + Saline group, and Morphine + Naloxone group; n = 5 mice in Saline + Naloxone group). Two-way ANOVA, conditioning

treatment factor, F (1, 19) = 15.90, p < 0.001; withdrawal treatment factor, F (1, 19) = 17.16, p < 0.001; conditioning treatment x withdrawal treatment

interaction, F (1, 19) = 23.56, p < 0.0001. ####p < 0.0001 versus Saline + Saline group, Morphine + Saline group, and Saline + Naloxone group by Bonferroni’s

post hoc test. Data are represented as mean G SEM.
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that in Saline + Saline group (6.254 G 0.7491/mm2), Morphine + Saline group (8.317 G 1.901/mm2), and Saline + Naloxone group (5.3 G

0.715/mm2) (two-way ANOVA, conditioning treatment factor, F (1, 19) = 32.94, p < 0.0001; withdrawal treatment factor, F (1, 19) = 24.61,

p < 0.0001; conditioning treatment 3 withdrawal treatment interaction, F (1, 19) = 27.11, p < 0.0001; Figure 4G). The average percentage

of the H2B-EGFP and c-Fos colabeling neurons relative to H2B-EGFP labeling neurons in the BLA in Morphine + Naloxone group

(8.82 G 1.09%) was also significantly higher than that in Saline + Saline group (3.26 G 0.38%), Morphine + Saline group (2.67 G 0.57%),

and Saline + Naloxone group (2.78 G 0.19%) (two-way ANOVA, conditioning treatment factor, F (1, 19) = 15.90, p < 0.001; withdrawal treat-

ment factor, F (1, 19) = 17.16, p < 0.001; conditioning treatment x withdrawal treatment interaction, F (1, 19) = 23.56, p < 0.0001; Figure 4H).

These results suggest that conditioning of context and morphine withdrawal can activate BLA neurons, and these activated BLA neurons

are reactivated during context-induced retrieval of morphine withdrawal memory, which provides the evidence for the presence of morphine

withdrawal memory engram cells in the BLA.

On this basis, we examined the influence of the inhibition of MEC�BLA neurons on context-induced reactivation of morphine withdrawal

memory engram cells of the BLA. AAV-DIO-hM4D(Gi)-mCherry or AAV-DIO-mCherry was bilaterally injected into the MEC, and rAAV-CRE,

AAV-c-fos-tTA and AAV-TRE3g-H2B-EGFP were bilaterally injected into the BLA of the mice. Four weeks after recovery of the surgery, mice

with the injection of AAV-DIO-hM4D(Gi)-mCherry were randomly divided into two groups: one was hM4D(Gi) + Saline group, in which the

mice received intraperitoneal injection of saline at 45 min before the post-test; another one was hM4D(Gi) + CNO group, in which the mice

received intraperitoneal injection of CNO at 45 min before the post-test to inhibit the MEC�BLA neurons. The mice with the injection of

AAV-DIO-mCherry were set as the empty vector control group (mCherry + CNO group), in which the mice received intraperitoneal injection

of CNO at 45 min before the post-test to exclude the effect of CNO on the CPA (Figure 5A). Figure 5B showed the diagram of virus injection.

Figure S7 showed the injection sites for data analysis in theMEC and theBLA. The result showed that context induced significant aversion to the

morphine withdrawal-paired compartment of the mice in hM4D(Gi) + Saline group and mCherry + CNO group but did not in hM4D(Gi) +

CNOgroupmice (two-way RMANOVA, CNO factor, F (2, 15) = 26.67, p < 0.0001; test factor, F (1, 15) = 65.23, p < 0.0001; CNO3 test interaction,

F (2, 15) = 3.994, p= 0.0407. Bonferroni’s multiple comparisons: there were no significant differences between groups in the pre-test: p > 0.9999;

thepost-test of hM4D(Gi) +CNOgroup vs. hM4D(Gi) + Salinegroup ormCherry+CNOgroup:p<0.001; Table S1F and Figure 5C). Then,mice

were sacrificed at 90 min after the post-test, and c-Fos staining was used to determine whether BLA neurons labeled with H2B-EGFP by the

conditioning of context and morphine withdrawal could be reactivated during the context-induced retrieval of morphine withdrawal memory

after the inactivation of MEC�BLA neurons (Figure 5D). The result showed that the average percentage of H2B-EGFP and c-Fos colabeling neu-

rons relative toH2B-EGFP labeling neurons of the BLA in hM4D(Gi) +CNOgroup (3.11G 0.34%) was significantly lower than that in hM4D(Gi) +

Saline group (5.11G 0.24%) and mCherry + CNO group (5.23G 0.14%) (one-way ANOVA, F (2, 12) = 22.47, p < 0.0001; Figure 5E). This result

suggests that MEC�BLA neurons participate in context-induced reactivation of morphine withdrawal memory engram cells in the BLA.

MEC�BLA neurons do not participate in the formation of morphine withdrawal memory

A possible reason for the involvement of MEC�BLA neurons in the context-induced retrieval of morphine withdrawal memory may be that

MEC�BLA neurons are first involved in the formation of morphine withdrawal memory and thus in the retrieval of morphine withdrawal
iScience 27, 110239, July 19, 2024 9
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Figure 5. The influence of MEC�BLA inhibition on the context-induced reactivation of morphine withdrawal memory engram cells of the BLA

(A) Behavioral schedule and groups of the mice.

(B) The diagram of virus injection into the BLA and the MEC.

(C) The average CPA scores in hM4D(Gi) + Saline group (n = 7) and hM4D(Gi) + CNOgroup (n = 5) andmCherry +CNOgroup (n = 6). Two-way RMANOVA, drug

factor, F (2, 15) = 26.67, p < 0.0001; test factor, F (1, 15) = 65.23, p < 0.0001; CNO 3 test interaction, F (2, 15) = 3.994, p = 0.0407. ****p < 0.0001 versus pre-test,
####p < 0.0001 versus post-test of hM4D(Gi) + Saline group or mCherry + CNO group.

(D) The H2B-EGFP labeling neurons, c-Fos labeling neurons, and H2B-EGFP and c-Fos co-labeling neurons in the BLA in three groups. Scale bar: 100 mm.

Magnified images showed the boxed areas. Scale bar: 20 mm.

(E) The average percentage of the H2B-EGFP and c-Fos co-labeling neurons relative to the H2B-EGFP labeling neurons in the BLA in three groups. (n = 5mice in

each group). One-way ANOVA, F (2, 12) = 22.47, p < 0.0001. ###p < 0.01 versus hM4D(Gi) + Saline group and mCherry + CNO group.

(F) The density of H2B-EGFP labeling neurons in the BLA in three groups. One-way ANOVA, F (2, 12) = 0.8569, p = 0.4489. Data are represented as meanG SEM.
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memory, that is, during conditioning of context and morphine withdrawal, the conditioning first activates MEC�BLA neurons and then estab-

lishes a MEC�BLA neuron pathway connecting context and morphine withdrawal memory, which would be used in later context-induced

retrieval of morphine withdrawal memory. To test this hypothesis, FG was bilaterally injected into the BLA to retrograde label MEC�BLA neu-

rons. One week after recovery from the surgery of FG injection, mice were randomly divided into four groups as described earlier and were

subjected to the behavioral training as illustrated in Figure 6A. Figure 6B showed the location of FG injection in the BLA. Figure S8 showed the

injection sites of FG for data analysis in each group. After the behavioral assay, animals were sacrificed at 90 min after the conditioning, and

the effect of the conditioning of context and morphine withdrawal on the expression of c-Fos of MEC�BLA neurons in different groups was

examined (Figure 6C). We could see the average percentage of the c-Fos and FG colabeling neurons relative to FG-labeling neurons in

the MEC in Morphine + Naloxone group (16.07 G 0.56%) had no significant difference compared to that in Saline + Saline group (14.6 G

1.32%), Morphine +Saline group (15.48 G 1.33%), and Saline + Naloxone group (14.76 G 1.43%) (two-way ANOVA, conditioning treatment

factor, F (1, 15) = 0.83, p = 0.38; withdrawal treatment factor, F (1, 15) = 0.098, p = 0.759; conditioning treatment x withdrawal treatment inter-

action, F (1, 15) = 0.032, p = 0.86l Figure 6D). This result suggests that MEC�BLA neurons are not activated by conditioning of context and

morphine withdrawal.

We also studied the role of MEC�BLA neurons in the coupling of context andmorphine withdrawal memory using a chemogenetic method

to inhibit MEC�BLA neurons before the conditioning of context and morphine withdrawal memory. AAV-DIO-hM4D(Gi)-EGFP or AAV-DIO-

EGFP was bilaterally injected into the MEC, and rAAV-CRE-mCherry was bilaterally injected into the BLA of the mice. Four weeks after recov-

ery from the surgery, the mice with the injection of AAV-DIO-hM4D(Gi)-EGFP were randomly divided into two groups: one was hM4D(Gi) +

Saline group, in which the mice received intraperitoneal injection of saline at 45 min before the conditioning sessions; another one was

hM4D(Gi) + CNO group, in which the mice received intraperitoneal injection of CNO at 45 min before the conditioning sessions to inhibit

the activity of MEC-BLA neurons during the conditioning sessions. The mice with the injection of AAV-DIO-EGFP were set as the empty vector

control group (EGFP+CNOgroup), in which themice received intraperitoneal injection of CNOat 45min before the conditioning sessions to

exclude the effect of CNOon theCPA (Figure 7A). Figure 7B showed the diagramof virus injection in theMEC and the BLA. Figure 7C showed

the mCherry-labeled neurons in the BLA and the EGFP-labeled neurons in the MEC. Figure S9 showed the injection sites for data analysis in

the MEC and the BLA. The result in Figure 7D showed that context induced a strong aversion to the morphine withdrawal-paired compart-

ment in hM4D(Gi) + Saline group, hM4D(Gi) + CNO group, and EGFP + CNO group (two-way RM ANOVA, CNO factor, F (2, 21) = 0.6916,

p = 0.5118; test factor, F (1, 21) = 156.0, p < 0.0001; CNO 3 test interaction, F (2, 21) = 1.871, p = 0.1787. Bonferroni’s multiple comparisons:

there were no significant differences between groups in the pre-test: p > 0.05 (Table S1G); the post-test of hM4D(Gi) + CNO group vs.

hM4D(Gi) + Saline group or EGFP + CNO group: p > 0.05; Table S1G and Figure 7D). This result suggests that the inhibition of MEC�BLA

neurons during training process does not affect the coupling of context andmorphine withdrawal memory. The abovementioned results indi-

cate that MEC�BLA neurons do not mediate the coupling of context and morphine withdrawal memory during training process and thus do

not participate in the formation of context-coupled morphine withdrawal memory.
DISCUSSION

The main findings of the present study are that MEC participates in context-induced retrieval of morphine withdrawal memory, and its pro-

jection neurons to the BLA (MEC�BLA neurons) play an important role in context-induced retrieval of morphine withdrawal memory and re-

activation of morphine withdrawal memory engram cells of the BLA, but MEC-BLA neurons do not participate in the formation of morphine

withdrawal memory.

A number of studies have shown that the MEC plays an important role in physiological processes underlying spatial navigation and mem-

ory. Lesion or drug-inducedMEC silencing in rodents has been associatedwith impaired performance in place navigation and spatial memory

tasks.3,20–22 A novel finding of present study is that under drug addiction condition, the MEC participates in context-induced retrieval of

morphine withdrawal memory. This finding indicates that if the MEC is inhibited, the context-induced retrieval of the morphine withdrawal

memory can be inhibited. However, the inhibition of the MEC is not a good strategy to prevent context-induced retrieval of morphine with-

drawal memory because theMEC has an important role in the spatial navigation and relatedmemory. This statement is supported by the fact

that the breakdown in homeostatic excitability mechanisms in theMEC contributes to the emergence of spatial memory deficits in Alzheimer

disease.23,24 Therefore, identifying the cell types within the MEC that are associated with context-induced retrieval of morphine withdrawal

memory is a prerequisite for accurately inhibiting the retrieval of morphine withdrawal memory.
iScience 27, 110239, July 19, 2024 11
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Figure 6. The influence of conditioning of context and morphine withdrawal on the activity of MEC�BLA

(A) Behavioral schedule and groups of the mice.

(B) Left: the diagram of FG injection into the BLA. Right: the injection site of FG in the BLA. Scale bar: 100 mm. Magnified images showed the boxed areas. Scale

bar: 20 mm.

(C) The c-Fos labeling neurons, FG labeling neurons, and c-Fos and FG co-labeling neurons in the MEC in four groups. Scale bar: 100 mm. Magnified images

showed the boxed areas. Scale bar: 20 mm.

(D) The average percentage of the c-Fos and FG co-labeling neurons relative to the FG labeling neurons in the MEC in four groups. (n = 5 mice in Saline+Saline

group, Morphine+Saline group, and Morphine+Naloxone group; n = 4 mice in Saline+Naloxone group). Two-way ANOVA, conditioning treatment factor,

F (1, 15) = 0.83, p = 0.38; withdrawal treatment factor, F (1, 15) = 0.098, p = 0.759; conditioning treatment x withdrawal treatment interaction, F (1, 15) = 0.032, p = 0.86.

(E) The density of FG labeling neurons in the MEC in four groups. Two-way ANOVA, conditioning treatment factor, F (1, 15) = 4.44, p = 0.05; withdrawal treatment

factor, F (1, 15) = 1.25, p = 0.28; conditioning treatment x withdrawal treatment interaction, F (1, 15) = 0.01, p = 0.92. Data are represented as mean G SEM.
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To inactivate the MEC during retrieval of morphine withdrawal memory, we employed muscimol, a GABAA receptor agonist, which could

induce a hyperpolarization of neurons via the activation of postsynaptic GABAA receptors.25 We did not use GABAB receptor agonist here

because GABAB receptor agonist could activate presynaptic GABAB receptors and inhibit presynaptic GABA release and thus increase

the excitability of postsynaptic neurons.26

The MEC is a six-layered cortex. The superficial layers of the MEC contain two morphologically distinct excitatory projection neurons:

the stellate and the pyramidal cells.27 The main excitatory cells in the superficial layers of the MEC project in a region-specific manner to

the hippocampus.27 The function of superficial layers of the MEC projecting to the hippocampus has been proposed to be mainly

related to spatial navigation and spatial memory.14 So here we did not examine the role of these superficial MEC projection neurons

in context-induced retrieval of morphine withdrawal memory. The layer 5 of the MEC contains excitatory neurons that project to the

prelimbic cortex (PrL) and the BLA.28,29 Our previous study showed that BLA neurons projecting to the PrL played an important role

in conditioned context-induced retrieval of morphine withdrawal memory.17 Therefore, it is possible that the MEC participates in the

retrieval of morphine withdrawal memory through its projection neuron to the BLA or the PrL. The present results show that context

could activate MEC�BLA neurons, and the inhibition of MEC�BLA neurons on context-induced retrieval of morphine withdrawal memory

suggested that MEC�BLA neurons were an important pathway mediating MEC-activation-induced retrieval of morphine withdrawal

memory. However, the role of MEC projection neurons to the PrL in context-induced retrieval of morphine withdrawal memory is still

under investigation.

The downstreambrain region ofMEC�BLA neurons is the BLA, which is a crucial brain region of drugwithdrawal memory.17,30Memories are

thought to be physically encoded in a sparsely distributed population of neurons, referred to as memory engram cells.31,32 Studies over the

past decades have identified memory engram cells in multiple brain regions that participate in encoding specific memories.33 In terms of

addiction memory, engram cells have been identified in several brain regions, such as drug reward memory engram cells located in ventral

CA1, nucleus accumbens core (NAcC) and anterior limbic cortex,19,34 and drug withdrawal memory engram cells located in the dentate gyrus

and nucleus accumbens.35,36 However, as far as the BLA is concerned, there is still a lack of studies showing the presence of drug withdrawal

memory engram cells in this region of the brain. To study how MEC-BLA neurons participate in context-induced retrieval of morphine with-

drawal memory, firstly, we examined whether there were drug withdrawal memory engram cells in the BLA and then examined the influence

of the inhibition ofMEC�BLA neurons, using chemogeneticmethod, on context-induced reactivation ofmorphine withdrawalmemory engram

cells of the BLA. Our results show that conditioning of context and morphine withdrawal can activate BLA neurons, and these activated BLA

neurons are reactivated by context during context-induced retrieval of morphine withdrawal memory, which provides the evidence for the

presence of morphine withdrawal memory engram cells in the BLA. Moreover, our results show that the inhibition of MEC�BLA neurons de-

creases context-induced reactivation of morphine withdrawal memory engram cells of the BLA. These results suggest that MEC�BLA neurons

may participate in context-induced retrieval of morphine withdrawal memory via the reactivation of morphine withdrawal memory engram

cells of the BLA.

Context-induced retrieval of morphine withdrawal memory is a typical Pavlovian conditioning paradigm in which an initially neutral stim-

ulus, such as environmental context (conditioned stimulus [CS]), is paired with morphine withdrawal symptoms (unconditioned stimulus [US]).

As a result of this pairing, neutral context acquires the aversive property of morphine withdrawal. Afterward, when presented alone, the

context elicits morphine withdrawal responses in the animal. The neural basis of the acquirement of morphine withdrawal property by neutral

context is that the pairing of neutral context and morphine withdrawal first activates some neural circuits and induces plastic change in these

circuits and then establishes neural pathways connecting context and morphine withdrawal, which lastly are used in later context-induced

retrieval of morphine withdrawal memory. Thus, previous studies have identified a number of this pairing-established pathways, such as

PrL to paraventricular nucleus of the thalamus (PVT),37 PVT to NAc,36 NAc to lateral hypothalamus (LH),38 and BLA to PrL.17 An unexpected

result of present study is that although MEC�BLA neurons are not activated by conditioning of context and morphine withdrawal and do not

participate in the formation of context-coupled morphine withdrawal memory, MEC�BLA neurons participate in context-induced retrieval of

morphine withdrawal memory. A similar phenomenon was also reported by Tonegawa et al., who showed that using the contextual fear-con-

ditioning paradigm, the inhibition of dorsal subiculum neurons had no effect on fear memory formation but could inhibit the retrieval of fear

memory.39 It was also consistent with the statement that there were distinct neural circuits for the formation and retrieval of memories.40,41

However, it remains unclear how it is possible that MEC�BLA neurons reported here and other neurons reported in literature42–44 are involved

in the retrieval of memories but not in the formation of memories.
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Figure 7. The influence of chemogenetic inhibition of MEC�BLA during conditioning on the coupling of context and morphine withdrawal memory

(A) Behavioral schedule and groups of the mice.

(B) The diagram of virus injection into the BLA and the MEC.

(C) Top: the expression of CRE-mCherry (red) in the BLA. Scale bar: 100 mm.Magnified images showed the boxed areas. Scale bar: 20 mm. Bottom: the expression

of hM4D(Gi)-EGFP (green) in the MEC. Scale bar: 100 mm.

(D) The average CPA scores in hM4D(Gi) + Saline group (n = 8), hM4D(Gi) + CNO group (n = 10), and EGFP + CNO group (n = 6). Two-way RM ANOVA, CNO

factor, F (2, 21) = 0.6916, p = 0.5118; test factor, F (1, 21) = 156.0, p < 0.0001; CNO3 test interaction, F (2, 21) = 1.871, p = 0.1787. ****p < 0.0001 versus pre-test. Data

are represented as mean G SEM.
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In conclusion, the present study suggests that the MEC participates in context-induced retrieval of morphine withdrawal memory, and

MEC�BLA neurons play an important role in context-induced retrieval of morphine withdrawal memory. However, MEC-BLA neurons do not

participate in the formation of morphine withdrawal memory. This finding indicates that in the Pavlovian conditioned reflex paradigm, uncon-

ditionally activated pathways also contribute to conditioned context-induced memory retrieval, in addition to pathways established by

context-memory pairing.
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Limitations of the study

Although the present study provides evidences suggesting that MEC�BLA neurons play an important role in context-induced retrieval of

morphine withdrawal memory, they do not participate in the formation of morphine withdrawal memory. However, we still do not know

how it is possible that MEC�BLA neurons are involved in the retrieval of memories but not in the formation of memories. This question needs

to be addressed further.
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Materials availability

This study did not generate new unique reagents.
Data and code availability

All data reported in this paper will be shared by the lead contact upon request.

This paper does not report original code.

Any additional information required to reanalyze the data reported in this paper is available from the lead contact upon request.
EXPERIMENTAL MODEL AND STUDY PARTICIPANT DETAILS

Animals

Male adult (8–12 weeks) C57BL/6 mice were housed singly in a 12 h light/dark cycle in a temperature- and humidity-controlled environment

with food and water freely available. All experimental procedures conformed to Fudan University as well as international guidelines on the

ethical use of animals and were approved by the Animal Care and Use Committee of the Shanghai Medical College of Fudan University

(No. 20200306-148). All efforts were made to minimize animal suffering and reduce the number of animals used. The total number of animals

used in this study is 230 and the total number of animals discarded is 15.

3-5 animals were randomly distributed into each group within an experiment. The experiments that resulted in significant behavioral dif-

ferences were replicated two or three times in our lab. According to the behavioral protocol, the brain slices including the fluorescence la-

beling were imaged. The data of the animals lacking correct labeling were excluded from the further analysis.
METHOD DETAILS

Stereotactic injection

Mice were anesthetized with 1.25% avertin (0.2 mL/10 g body weight) before the stereotaxic surgery was performed. For the retrograde

neuronal tracing, the mice were bilaterally injected with FG (0.3 mL each side; 5 mM dissolved in 0.9% saline; Fluorochrome, USA) into the

BLA (AP, �1.4 mm; ML, G3.35 mm; DV, �4.35 mm) based on the atlas of Paxinos and Franklin (2001). For the activation of MEC�BLA, the

mice were bilaterally injected with rAAV-EF1a-Cre-mCherry (0.3 mL each side; 5.26 3 1012 vector genomes/mL; BrainVTA, China) into

the BLA, and were bilaterally injected with AAV-EF1a-DIO-hM3D(Gq)-EGFP (0.3 mL each side; 4.68 3 1012 vector genomes/ml; BrainVTA,

China) into the MEC (AP, �4.75 mm; ML, G3.46 mm; DV, �4.28 mm). For the inhibition of MEC�BLA, the mice were bilaterally injected

with rAAV-EF1a-Cre-mCherry into the BLA, and were bilaterally injected with AAV-hSyn-DIO-hM4D(Gi)-EGFP (0.3 mL each side; 5.69 3

1012 vector genomes/mL; BrainVTA, China) into the MEC. Microinjections were performed using glass electrode connected to a 1 mL micro-

syringe (Hamilton) by polyethylene tubing and controlled by a syringe pump (Harvard Apparatus). After injection, the needle was retained in

the target site for additional 10 min to optimize diffusion.
Engram cell labeling

Mice were anesthetized with 1.25% avertin (0.2 mL/10 g body weight) before the stereotaxic surgery was performed. Tet-off system was used

for engram cell labeling. For engram cell labeling of the BLA, mice were injected with AAV-c-Fos-tTA and AAV-TRE3g-H2B-EGFP (0.3 mL each

side; 5.41 3 1012 vector genomes/mL; BrainVTA, China) into the BLA. The mice were fed with food containing DOX (42 mg/kg) before con-

ditioning. After the saline-paired conditioning on day 1 of conditioned place aversion (CPA), the diet was replaced by normal food without

DOX to allow the gene expression which was under the control of the tetracycline responsive element (TRE) combiningwith the tTA. Two trials

of naloxone-paired conditioning were performed on days 2 and 3 and the activated neurons could be labeled by H2B-EGFP. After these two

trials, the food containing DOX (1 g/kg) was provided immediately. Then the saline-paired conditioning was performed on day 4.
Cannula embedment

Mice were anesthetized with 1.25% avertin (0.2 mL/10 g body weight) before the stereotaxic surgery was performed. For the cannula embed-

ment, the mice received two stainless-steel guide cannulas (O.D. 0.48 mm3 I.D. 0.34 mm; C = 3.3 mm; RWD, China) embedding 1mm above

theMEC. Cannulas were secured to the skull with anchoring screws and dental cement. Stainless steel stylets were inserted into the cannula to

prevent the occlusion. Themice were allowed to recover for one week after the surgery. Injection needle inserted into cannula was connected

to a 1 mL microsyringe by polyethylene tube and controlled by a syringe pump. Muscimol (0.3 mL each side; 0.11 mg/mL dissolved in 0.9%

saline; Sigma, USA) or 0.9% saline was injected bilaterally into the MEC through the cannulas for 1 min at 30 min before the post test of CPA.
Chronic morphine treatment

Mice were treated with morphine (Shenyang No.1 Pharmaceutical Factory, China) according to the procedures previously described.17

Morphine dependent was induced in mice by intraperitoneal injection of morphine twice daily at 9:00 a.m. and 19:00 p.m. The morphine

does was progressively increased from 10 mg/kg to 40 mg/kg: 10 mg/kg on day 1, 20 mg/kg on day 2, 30 mg/kg on day 3, 40 mg/kg on

day 4 and 40 mg/kg on day 5. The mice in control group were treated with equivalent volume of saline following the same procedure.
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Conditioned place aversion (CPA)

CPA was conducted in a three-compartment place conditioning apparatus (Med Associates, USA) with distinct visual and tactile context. The

procedure of CPA was similar to that described previously.17

On pre-test day (day 1), the mice were placed in the central neutral area of the apparatus for 2 min and then allowed to explore the three

compartments freely for 15 min. The mice showing strong preference or aversion of any compartment were discarded (i.e., >75% or <25% of

the session time; the number of excluded animals did not exceed 10% of the sample). All eligible mice were randomly divided into four

groups: Saline+Saline, Morphine+Saline, Saline+Naloxone and Morphine+Naloxone.

On drug treatment day (day 2–6), themice were treated withmorphine (i.p., for Morphine+Saline andMorphine+Naloxone groups)/saline

(i.p., for Saline+Saline and Saline+Naloxone groups) for five consecutive days as described above.

On conditioning days (days 7 and 9), 2 h after 40 mg/kg morphine/saline intraperitoneal injection, the mice were treated with 0.3 mg/kg

naloxone (i.p., for Saline+Naloxone and Morphine+Naloxone groups)/saline (i.p., for Saline+Saline and Morphine+Saline), and were then

immediately confined in the naloxone-/saline-paired compartment for 20 min. In this process, mice in Morphine+Naloxone group were

forced to induced morphine withdrawal after naloxone injection. On conditioning days (days 8 and 10), 2 h after 40 mg/kg morphine/saline

intraperitoneal injection, the mice were treated with saline (i.p., for each group), and were then immediately confined in the opposite side of

naloxone-/saline-paired compartment for 20 min.

On post-test day (day 11), 24 h after the last conditioning session, the mice were allowed to explore the three compartment freely for

15 min to assess the CPA response. The CPA score was defined as the time spent in the naloxone-paired compartment minus the time spent

in the opposite side of naloxone-paired compartment. Since the withdrawal conditioning was performed in the minor preference compart-

ment, the CPA scores of pre-test were positive; after the withdrawal conditioning, the mice spent less time in this compartment so that the

CPA scores of post-test were negative.

Immunofluorescence staining and imaging

Mice were anesthetized with 1.25% avertin (0.2 mL/10g body weight) and were perfused with 0.9% saline, followed by an ice-cold solution of

4% paraformaldehyde (PFA). The brains were rapidly removed and fixed in the 4% PFA overnight at 4�C. The brains were sliced into 40 mm

coronal sections using a vibratome (Leica, Germany), and the slices were collected into the 0.01 M phosphate-buffered saline (PBS). Free-

floating sections containing the MEC (�4.36�-5.02 mm, range relative to bregma), the BLA (�1.24�-1.60 mm, range relative to bregma)

were rinsed in 0.01 M PBS three times. Subsequently, sections were blocked with blocking solution containing 10% normal goat serum

and 0.3% Triton X-100 in PBS for 2 h at 37�C, and were then incubated with primary antibody at 4�C overnight. The slices were washed three

times in 0.01M PBS and then were incubated with biotinylated secondary antibody or Alexa 488 at 37�C for 1 h. After washed three times with

0.01M PBS, the slices incubated with biotinylated secondary antibody were incubated with Cy3-conjugated streptavidin (1:1000; Vector, USA)

at 37�C for 1 h. Finally, slices were cover-slipped on anti-quenching mountingmedium (Thermo Fisher Scientific). All primary antibodies were

dissolved into 10% normal goat serum and 0.3% Triton X-100 in PBS, and other antibodies were dissolved into 10% normal goat serum in PBS.

For primary antibodies, we used antibodies against c-Fos (guinea pig, 1:500; Synaptic System, Germany) and NeuN (rabbit, 1:200; Sigma-

Aldrich, USA). For the secondary antibody, we used biotinylated goat anti-guinea pig antibody (1:500; Vector, USA) and Alexa 488 (1:500;

Abcam, UK). Some sections were finally stained by DAPI (1:1000, Sigma, USA).

The brain slices were scanned by confocal microscope (Olympus IX71; Nikon, Japan) with a 103 lens and the images were collected at a

resolution of 10243 1024 pixels. Laser diode wavelengths of 405, 488 and 561 nmwere used. The same laser and scanning settings were used

for all coronal slice within one experiment to allow for accurate comparison across groups.

Cell counting

To further ensure the accuracy of image processing and statistics, coronal sections from at least 4 mice in each group were used for quan-

titative analysis.

Automated cell counting was conducted using the ImageJ software. 1) Images opening and areameasurement: The image of interest was

imported through ‘‘File->Open’’ option on the tool bar. The boundaries of each brain region were outlined as a region of interest (ROI) ac-

cording to themouse brain atlas through the ‘‘polygon selections’’ tool. ‘‘Analyze->Measure’’ optionwas clicked and the areawas displayed in

the ‘‘Results’’ window. ‘‘Analyze->Tools->ROI Manager->add’’ was clicked and the ROI was added in the ‘‘ROI Manager’’ window. 2) C-Fos

counting: The images were converted into 8-bit using ‘‘Image->type->8 bit’’ option. Then the ‘‘Image->adjust->threshold’’ was clicked from

the tool bar to set threshold. The top sliding bar was set to 39, the bottom sliding bar was set to 111 to make the red highlight maximally

covering the area defined as c-Fos positive neurons without impact on the background area. The ROI was selected by clicking the number

in the ROImanager window. Then, the number and size of c-Fos positive neuronsweremeasured through ‘‘Analyze->Analyze Particles’’. In the

pop-up window, the threshold, 40, was set in the ‘‘Size’’ box to define the minimum area of the c-Fos positive neurons. ‘‘OK’’ was clicked and

the number and size would be presented in the ‘‘Result’’ window. Figure S10 showed the representation of the raw image and the ‘‘counted’’

image. 3) FG counting: The images were converted into 8-bit using ‘‘Image->type->8 bit’’ option. Then the ‘‘Image->adjust->threshold’’ was

clicked from the tool bar to set threshold. The top sliding bar was set to 39, the bottom sliding bar was set to 111 to make the red highlight

maximally covering the area defined as FG positive neurons without impact on the background area. The ROI was selected by clicking the

number in the ROImanagerwindow. Then, the number and size of FGpositive neuronsweremeasured through ‘‘Analyze->Analyze Particles’’.

In the pop-up window, the threshold, 50, was set in the ‘‘Size’’ box to define the minimum area of the FG positive neurons. ‘‘OK’’ was clicked
20 iScience 27, 110239, July 19, 2024



ll
OPEN ACCESS

iScience
Article
and the number and size would be presented in the ‘‘Result’’ window. 4) hM4D(Gi)-EGPF counting: The steps were similar to FG counting. 5)

H2B-EGFP counting: The steps were similar to c-Fos counting.

Manual cell counting of co-staining of c-Fos and FG, c-Fos and H2B-EGFP or c-Fos and hM4D(Gi)-EGPF was conducted using the ImageJ

software.

The data collected from 5-7 slices per mouse were averaged to get one final value. All these counting experiments were conducted blind

to the experimental group.
Drugs

Morphine was purchased from northeast pharmaceutical group Shenyang of China. Naloxone and Clozapine-n-oxide (CNO) were purchased

from Selleckchem. Various AAV viruses were purchased fromBrainVTA company of China. Guinea pig anti-c-Foswas purchased fromSynaptic

System. NeuN, CY3-conjugated streptavidin, Doxycycline (DOX), Muscimol and Avertin were purchased from Sigma-Aldrich. Biotinylated

goat anti-guinea pig IgG antibody was purchased from Vector. Alexa 488 was purchased from Abcam. DAPI and Normal goat serum were

purchased from Beyotime. Triton X-100 was purchased from Biosharp. Fluorogold (FG) was purchased from Flurochrome. Morphine,

Naloxone, CNO, DOX, Muscimol and Avertin were dissolved in saline. Specific information on the various drugs can be found in the key re-

sources table.
QUANTIFICATION AND STATISTICAL ANALYSIS

Statistical analyses for all data were performed with Graphpad Prism 8 and SPSS 27. Statistic significant was detected using Student’s t test

between two groups. Multiple group comparisons were assessed using one-way analysis of variance (ANOVA) or two-way ANOVA, followed

by post-hoc Bonferroni’s test when significant interactions were detected. Group differences of behavioral test were detected using two-way

repeated measures ANOVA, followed by Bonferroni’s post-hoc tests with test as a within-subject factor and drug treatment as a between-

subject factor. In all cases, n refers to the number of animals. For all results, data were presented asmeanG SEM and p< 0.05 was considered

statistically significant. Statistical details of Bonferroni’s post-hoc tests of behavioral test can be found in Table S1.
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